
ANM	324	Project	1			
For	most	of	you,	this	first	project	is	an	adventure	and	a	significant	challenge	because	you	are	
using	a	totally	new	piece	of	software	with	drawing	tools	that	don’t	feel	very	natural.		I	
appreciate	those	challenges	and	try	to	push	you	a	bit	in	how	you	look	at	these	everyday	
objects.		You’ll	be	seeing	your	skill	with	Illustrator	grow	enormously	over	the	course	of	the	first	
two	projects.		Keep	up	the	good	work!			
		
Here’s	my	general	grading	criteria	for	this	project:		
Note:	5pts	deducted	for	missing	group	critique	10pts	for	missing	submission	deadline.		You	can	
view	your	grade	and	additional	comments	regarding	late	submissions	or	missing	comments	in	
the	gradebook.	
		
95---100---drawing	is	accurate,	demonstrates	good	control	of	tools	and	includes	accurate	
lighting	effects	(your	subject	had	a	high	level	of	difficulty)		
90---95---drawing	is	accurate,	shows	adequate	control	of	tools	lighting	and	fills	considered	but	
not	complete	or	accurate	(subject	not	as	challenging)		
85---90---drawing	is	accurate,	fills	not	complete,	lighting	not	adequately	considered	80---85---
drawing	and	use	of	tools	lacks	control,	lighting	not	adequately	considered	70---80---drawing	not	
controlled,	lighting	not	considered		
70---below	very	late	work	
	
Frasier	Group	
Billy	Bowles-You’ve	done	an	excellent	job	on	your	Xbox	Controller!	You’ve	used	layers	to	very	
effectively	separate	content	for	easy	editing.	I’m	most	impressed	with	the	use	of	gradients	on	
the	controller	body	and	buttons.	This	gives	them	dimension	and	a	tactile	look.	The	letters	on	
the	buttons	look	very	authentic	as	does	the	X	logo.	My	only	suggestion	would	be	to	modify	the	
gradient	on	the	large	+	button	to	make	it	a	little	more	visible	and	consistent	with	the	light	level	
on	the	other	buttons.	I	see	a	“hint”	of	a	cast	shadow…with	such	strong	lighting	on	the	surface,	
the	controller	would	cast	a	more	well	defined	shadow.	Yes…I’m	being	picky.	
	
Sarah	Greenig-Good	job	adding	the	details	to	your	iPhone	illustration.	I	particularly	like	the	
edge	buttons	and	the	charger	cord.	Lighting	effects	are	very	strong	too-giving	us	the	impression	
of	bright	source	to	the	top	left.	This	is	reinforced	with	the	gradient	on	the	screen…nice	work	
applying	that	gradient.	Because	we	are	seeing	the	left	edge	of	the	phone,	the	body	should	be	
slightly	adjusted	to	account	for	perspective.	Use	the	direct	selection	arrow	to	adjust	the	shape	
of	layers	as	you	build-up	your	illustration.	There	is	also	an	Effect>Distort>Free	Distort	that	can	
be	used	to	make	slight	adjustment	to	add	realism..we’ll	get	more	into	these	techniques	with	
the	next	project.	The	cast	shadow	of	the	phone	body	is	offset	a	bit	too	much.	As	a	result,	it	
looks	like	the	phone	is	hovering	slightly	above	the	surface.	I	did	not	see	a	group	critique.	
	
Diego	Juarez-The	view	you	chose	is	amazing	and	adds	significant	difficulty	to	the	illustration.	I’m	
not	familiar	with	this	controller	but	the	detail	and	perspective	gives	us	great	insight	into	its	
function.	I	especially	like	your	use	of	gradients	to	define	the	curved	edges	of	the	body	and	
buttons…very	well	done!	I	was	a	little	confused	by	the	orientation	of	the	button	names	vs	the	



SONY	logo.	I	could	flip	it	but	it	would	then	read	SONY	upside	down…didn’t	make	sense	to	me	
that	you	use	the	controller	upside	down.	I	guess	I	need	to	research	this	system	a	bit	more.	I	do	
have	a	couple	of	suggestions:	you’ve	used	the	visible	stroke	to	define	the	edge	of	the	
controller..better	to	leave	that	at	no-stroke	(especially	where	it’s	visible	below	the	blue	triangle.	
I	would	also	like	to	see	a	cast	shadow	of	the	controller	to	ground	it	on	a	surface.	
	
Lesly	Lopez-You’ve	really	captured	the	thin	detail	of	this	iPhone	6!	The	buttons,	speaker	and	
charging	ports	are	especially	well-done!	The	perspective	looks	great…this	is	tricky	but	you’ve	
done	an	excellent	job	of	adding	realism	to	the	form.	The	use	of	a	gradient	on	the	screen	
emphasizes	the	light	source	from	top	left	and	informs	us	about	the	shiny	surface	texture.	
Suggest	in	future	work	you	consider	not	using	a	stroke	to	define	shapes…for	example,	the	base	
of	the	phone	would	not	actually	be	a	black	line.	It	would	probably	be	better	defined	with	a	
gradient	fill	on	the	edges.		A	cast	shadow	would	help	“ground”	the	phone	and	further	reinforce	
the	lighting	source.	
	
Kelsey	Moon-It’s	always	fun	to	see	a	different	style	of	controller.	I’m	not	sure	what	this	Phillips	
controller	is	linked	to	but	it	must	be	for	an	audio	system.	The	detail	you’ve	drawn	is	wonderful!	
The	buttons	and	text	are	precise	and	very	realistic.	I	see	that	you	discovered	the	drop	shadow	
effect	which	adds	consistent	relief	to	the	buttons.	The	gradient	on	the	body	gives	it	form	and	
the	shadow	around	the	right	and	bottom	very	effectively	ground	the	controller	and	emphasizes	
the	light	source.	Excellent	work!	
	
Kyle	Spencer-Your	“joy	stick”	is	fun	and	offers	challenging	shapes	and	an	interesting	perspective	
to	illustrate.	It	looks	like	you’re	off	to	a	good	start	drawing	the	basic	forms	that	build-up	the	
stick.	The	solid	color	fills	result	in	a	two	dimensional	look.	I	would	like	to	see	some	simple	
gradients	to	show	the	rounded	grip	and	illustrate	a	light	source	on	the	shapes.	Another	
technique	to	consider	is	when	to	use	stroke	vs	no-stroke.	It’s	sometimes	easier	to	start	with	a	
stroke	to	define	shapes	but	where	the	stroked	line	isn’t	realistic,	just	remove	it	and	use	the	fill	
to	define	the	shape.	You	should	try	to	complete	this	illustration	on	your	own..it	will	utilize	
important	skills	we’ll	use	in	the	next	project.	
	
Rosenwald	Group	
Aziza	Atebar-	Wow!	The	background/wallpaper	image	on	your	phone	looks	great!	I	did	check	
out	the	detail	and	see	that	you	drew	the	individual	flowers.	Hopefully	you	drew	one	and	
duplicated/transformed	to	fill	the	background.	The	effect	really	is	very	strong.	The	detail	on	the	
phone	body	is	also	very	well	illustrated.	The	use	of	gradients	and	contrasting	tints	give	amazing	
realism	to	the	phone	body	and	buttons.	The	top	view	is	less	challenging	than	a	view	with	
perspective	but	it	still	is	very	well	done!	A	cast	shadow	off	the	body	would	be	a	nice	added	
feature	to	further	establish	form	and	reinforce	the	light	source.	
	
Christine	Herrera-Your	controller	definitely	gave	you	practice	at	drawing	all	those	buttons	and	
aligning	them	on	the	surface.	Hopefully	you	took	advantage	of	copy/paste	to	draw	one	style	
and	duplicate	it.	You’ve	used	stroke	outlines	on	those	buttons	to	show	perspective…the	next	
step	would	be	to	fill	the	shapes	with	grayscale	tints	to	better	illustrate	the	form	and	lighting	



effects.	I	noticed	one	clever	technique	you	used	to	give	the	body	the	curved	form.	By	layering	a	
filled	oval	shape	over	the	rectangular	body	you	give	it	that	curve.	Since	we	hadn’t	worked	with	
the	curvature	or	pen	tool	this	a	great	technique	to	illustrate	a	complex	shape.	Overall,	I	would	
like	to	see	more	well	defined	shadows	and	even	a	cast	shadow	to	ground	your	controller	on	a	
surface.		
	
Jennifer	Luce-You	added	lots	of	interesting	detail	to	your	phone	illustration.	The	screen	
charging	icon	is	particularly	engaging	with	it’s	colorful	treatment.	Because	the	view	is	from	the	
top,	it’s	not	quite	as	challenging	as	a	perspective	view	but	you	have	added	the	cord	and	screen	
image	for	increased	difficulty.	I	would	like	to	see	a	cast	shadow	off	the	phone	body	and	perhaps	
a	hint	of	a	shadow	off	the	charger	cord	to	add	depth	and	form	as	well	as	clarifying	the	dominant	
light	source.	
	
Olena	Svidersky-The	detail	you’ve	added	to	the	phone	gives	it	very	strong	realism.	I	especially	
like	the	gold	color	applied	as	a	gradient.	This	adds	an	interesting	highlight	but	also	tells	us	
where	the	dominant	light	it	coming	from.	I	would	like	to	see	this	reinforced	with	the	cast	
shadow..the	easiest	way	to	apply	is	with	the	Effect>Drop	Shadow	on	the	rectangular	body	
shape.	One	thing	I	noticed	was	that	you	apparently	used	a	png	image	of	the	Samsung	logo	
(which	is	fine)	but	it	did	not	transfer	with	the	file.	In	order	to	include	with	the	file	once	you	
place	it,	you	select	imbed	(property	menu).	This	will	keep	it	with	the	vector	illustration.	
	
Sarah	Worthington-Your	Xbox	controller	has	some	very	strong	effects.	I	like	the	detail	you’ve	
included	with	the	buttons..especially	the	colored	buttons	with	letters.	You’ve	incorporated	
lighting	effects	most	effectively	on	the	thumb	+	button.	The	highlight	on	the	round	colored	
buttons	is	a	strong	feature	too.	I	would	like	to	see	more	consistent	treatment	of	the	effects.	For	
example,	the	thumb	control	at	top	left	has	a	hint	of	shadow	form	but	it	would	better	if	a	
gradient	was	applied	to	it.	I	think	the	white	outline	is	your	version	of	a	cast	shadow.	It’s	creative	
but	not	as	realistic	as	it	could	be.	Curved	edges	are	a	little	rough…this	is	expected	at	this	stage	
of	learning	illustrator…once	you	gain	confidence	with	the	pen	tool	you’ll	be	able	to	draw	this	
type	of	shape	with	ease.	
	
Kroencke	Group	
Saundra	Fouhy-Your	phone	illustration	is	amazing!	One	of	the	most	successful	in	class.	You’ve	
worked	hard	to	understand	the	toolset	and	use	it	effectively	to	create	a	very	realistic	rendering.	
I	especially	like	your	use	of	gradients	to	reveal	the	surface	treatment	(shiny)	and	reinforce	the	
direction	of	the	dominant	light	source	from	top	left.	This	source	is	further	illustrated	with	the	
slightly	blurred	cast	shadow	off	the	phone	body.	To	top	it	off,	the	type	and	icons	are	precise.	
You	have	lots	of	layers	which	are	created	with	each	new	vector	you	draw	or	letter.	In	future	you	
will	find	that	grouping	in	logical	sets	will	make	it	easier	to	control/lock	and	edit	parts	of	complex	
illustrations.	Excellent	work.	Look	forward	to	seeing	your	next	project.	
	
Genevieve	Hardin-It’s	fun	to	see	your	classic	Nintendo	controller.	The	top	view	is	relatively	
simple	and	avoids	the	more	difficult	challenges	of	perspective.	You’ve	done	a	very	good	job	of	
drawing	the	components	of	the	controller.	The	buttons	are	precise	and	the	center	panel	shows	



a	cast	shadow	to	give	us	the	illusion	that	they	are	raised.	It	would	be	stronger	to	see	a	stronger	
drop	shadow	effect	applied	to	the	red	buttons	and	the	+	thumb	button.	I	see	that	you	have	
applied	one	but	it’s	only	offset	1px	so	it’s	very	hard	to	see.	The	cast	shadow	off	the	body	does	
give	the	controller	depth	and	form.	In	future	you	will	learn	how	to	manage	layers	so	that	logical	
groups	are	created	to	make	them	easier	to	edit.	
	
Noah	Martin-Your	basic	phone	shape	is	good	although	with	the	view	you	have	showing	the	left	
side,	there	should	also	be	some	adjustment	of	the	phone	body	to	account	for	perspective.	As	
we	learn	more	about	editing	anchor	points	you’ll	see	that	corners	can	be	moved	to	make	them	
more	precise.	The	round	buttons	on	the	side	could	also	be	drawn	as	slight	ellipsis	to	show	that	
they	are	distorted	as	we	are	looking	down	on	them.	I	do	like	the	added	gradient	on	the	screen	
which	implies	a	shiny	surface…that’s	a	great	technique	to	use.	The	charger	cord	adds	some	
difficulty	to	the	illustration..I	know	it’s	white	but	it	would	compliment	the	phone	better	if	it	
were	filled	with	a	slight	grayscale	tint	and/or	had	a	cast	shadow	applied	to	show	how	it	would	
look	if	resting	on	a	surface.	An	added	cast	shadow	off	the	phone	body	would	also	ground	it	and	
enhance	the	three	dimensional	effect.	
	
Denise	Phillips-Good	to	see	a	classic	Nintendo	controller…those	were	the	days!	Your	view	of	the	
device	is	significantly	more	challenging	due	the	perspective	of	both	halves.	You’ve	managed	the	
perspective	very	well	and	it’s	believable.	The	corners	are	tricky	and	in	the	lower	right	there’s	a	
sharp	edge	that’s	made	visible	by	the	tint	of	the	stroke…consider	using	no-stroke	to	define	the	
overall	shape	and	just	modify	the	fill	to	make	sure	the	full	surface	area	is	visible	(left	side	is	
white	so	it	will	vanish	if	stroke	is	removed.	Your	buttons	look	good	and	the	added	gradient	and	
drop	shadows	give	them	relief	and	define	the	light	source.	The	three-button	bar	at	the	bottom	
isn’t	consistent	with	the	general	perspective	or	surface	treatment.	I	think	this	is	due	to	the	dark	
stroke	which	brings	it	visually	forward.	Try	a	gradient	fill	across	all	three	buttons	and	bring	the	
stroke	width	for	the	outer	shape	down	to	.5	or	.25	(stroke	palette)	to	soften.		The	cast	shadow	
on	the	body	is	perfect.	
	
Vincent	Tiuseco-I	really	like	the	view	you’ve	chosen	for	your	Playstation	controller.	I’m	also	
impressed	with	the	smooth	curves	you’ve	drawn	for	the	handles…that’s	tricky	since	we	really	
haven’t	gotten	into	the	pen	and	curvature	tools.	The	buttons	and	shaped	elements	are	also	
very	precise..well	done!	The	downside	is	that	the	controller	should	be	filled	to	give	it	form	and	I	
would	also	expect	some	attention	to	the	effect	of	light	on	the	device.	You	have	obviously	
gained	skill	with	the	drawing	tools	which	will	be	essential	for	the	next	project.	The	addition	of	
fills,	gradients	and	shadows	will	be	needed	to	really	bring	your	illustrations	to	“life”.		
	
Melissa	West-You’ve	done	a	great	job	illustrating	the	Samsung	phone!	The	addition	of	the	case	
and	graphics	along	the	edge	add	difficulty	that	I	like	to	see.	Lighting	effects	are	illustrated	with	
the	gradient	on	the	screen	and	the	cast	shadow…these	both	reinforce	the	direction	of	light	
from	the	top	left.	I	would	expect	to	see	the	button	at	the	bottom	also	highlighted	with	a	
shadow	to	show	that	it’s	concave.	The	easiest	way	to	do	this	is	with	a	gradient	that’s	darker	on	
the	left	side.	You’ve	used	named	layers	to	effectively	group	parts	of	the	phone…this	as	a	critical	
skill	as	we	move	into	more	complex	compositions.	



	
Kunz	Group	
Barbara	Blair-I’m	impressed	with	the	detail	you’ve	included	in	your	old	school	soccer	controller.	
You	definitely	did	some	research	to	figure	out	how	to	use	mesh	points	on	the	top	screen…we’ll	
learn	how	to	use	it	to	apply	amazing	gradients	in	a	couple	weeks.	The	buttons	and	text	are	all	
very	precisely	drawn	and	colorized.	The	shadow	on	the	body	helps	ground	the	controller	but	it	
might	look	a	bit	better	if	was	slightly	blurred.	Since	your	shadow	is	created	with	a	separate	
shape,	you	apply	a	blur	by	going	to	Effect>Blur>Gaussian	Blur.	It	would	be	a	plus	to	also	add	
some	shadow	to	the	buttons	to	show	their	relief.	Select	the	shape,	such	as	the	arrows,	and	go	
Effect>Stylize>Drop	Shadow.	
	
Alisia	Gomez-I	like	the	technique	you’ve	used	to	add	highlights	to	your	buttons	in	addition	to	
gradients	on	the	yellow	ones.	The	arcs	and	line	segments	give	us	the	illusion	of	a	directional	
light	source.	You’ve	done	an	excellent	job	of	illustrating	the	curved	features	of	the	hand	
controller.	I	suggest	you	consider	no-stroke	for	the	outline	of	the	main	handles…this	would	
make	the	form	a	bit	more	realistic	and	smoother.	The	application	of	gradients	helps	define	the	
surfaces	and	reinforces	the	direction	of	light	on	the	device.	The	cast	shadow	of	the	controller	
further	shows	us	consistent	lighting	and	grounds	the	device	as	if	it	were	on	a	flat	surface.	Lots	
of	good	skills	put	to	use	here!	
	
Malaia	Jackson-I	really	like	your	charger	cord!	OK	the	illustration	of	the	phone	is	good	but	the	
colored	cord	really	stands	out	and	has	excellent	detail.	The	detail	on	the	phone	is	very	good	but	
the	perspective	is	a	bit	too	exaggerated.	The	screen	should	be	moved	further	left	so	that	the	
right	edge	of	the	phone	rim	is	more	visible.	You’ve	used	gradients	to	show	the	smooth	screen	
surface.	Good	job	applying	a	Gaussian	blur	on	the	bottom	layer	to	reinforce	the	dominant	light	
and	ground	the	device.	
	
Ivan	Little-Your	iPhone	illustration	has	some	excellent	detail…such	as	the	charger	cord	which	
looks	great.	The	phone	body	has	good	button	shapes	but	there	appears	to	be	some	alignment	
issues	with	home	button	and	screen	slightly	offset.	Illustrator	has	several	built-in	alignment	
features,	even	a	grid	(View>Show	Grid).	There	is	also	a	conflict	with	the	perspective,	which	is	
primarily	a	top	view,	but	the	top	edge	of	the	phone	is	visible.	In	this	case,	it’s	better	to	not	show	
that	end	and	just	stick	to	the	top	view.		Good	job	with	the	cast	shadows	which	help	us	see	the	
phone	shape,	dominant	light	source	and	grounding	on	the	surface.		
	
Cameron	Mayfield-You	definitely	win	the	award	for	the	most	unusual	controller.	As	I	look	at	it	
I’m	trying	to	imagine	how	it	feels	when	you	grip	it.		I	suspect	that	some	edges	aren’t	quite	as	
sharp	as	the	illustration	shows.	You’ve	done	a	very	good	job	of	rendering	this	complex	subject.	
The	buttons	and	thumbwheel	(my	favorite)	look	very	realistic.	Gradients	applied	to	some	
surfaces	help	us	visualize	the	form.	The	cast	shadow	is	a	little	harsh	and	not	as	well	defined	as	it	
could	be	based	on	a	single	dominant	light	source.	One	way	to	deal	with	this	is	to	soften	with	a	
blur	or	make	it	more	transparent	so	it	doesn’t	compete	with	the	illustration	of	the	device	itself	
but	still	supports	our	understanding	of	the	form.	
	



Adriana	Rodriguez-Wow!	Your	phone	looks	wonderful.	You’ve	captured	all	the	button	details	
very	precisely	and	added	gradients	and	lighting	effects	to	give	us	a	very	realistic	illustration	of	
the	device.	Your	screen	gradient	adds	energy	and	somewhat	reinforces	the	light	source.	The	
treatment	of	the	number	buttons	is	especially	strong	although	the	font	size	for	alphanumerics	
changes	to	adapt	to	space	on	the	buttons…better	to	keep	letters	all	the	same	size	for	
consistency.	This	is	such	a	minor	point	considering	the	strength	of	the	illustration	and	
techniques	you’ve	used.	The	cast	shadow	completes	the	picture	and	gives	the	phone	form.	
Excellent	work!	
	
Madeline	Villena-Thanks	for	adding	some	“brightness”	with	your	colored	Nintendo	controller.	
I’m	struck	by	the	smooth	curves	and	very	symmetrical	body	of	your	controller.	I	know	that	
required	some	research	and	practice	since	we	haven’t	gotten	into	the	tools	that	make	this	
easier	to	accomplish.	The	details	on	the	various	buttons	are	strong.	This	is	especially	true	for	
the	thumb	control	on	top	left	which	has	depth	thanks	to	the	use	of	a	gradient.	Lighting	effects	
have	been	primarily	set	by	adding	highlight	shapes,	which	is	fine.	One	way	to	make	this	even	
more	realistic	is	to	slightly	blur	with	the	Effects>Blur>Gaussian	Blur.	The	degree	of	blur	would	
be	based	on	the	surface	finish.	I’m	being	picky	but	you	could	enhance	your	illustration	with	
some	soft	cast	shadows	off	the	buttons	that	have	relief	and	perhaps	the	body	itself	to	show	
that	it	is	resting	on	a	surface.	Look	forward	to	seeing	the	next	project.	
	
	


